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1.MX28 Linux Bring Up
Hands On




Development Environment

A VMWare Ubuntu Image was provided to you for the
hands on sessions

- User: madfsl
- Password: madfsl

- But, let’'s have a look at the instructions for you to start
your own image

- If you want to prepare your development environment in a PC
natively (out of the virtual machine environment), you can use
the same instructions as reference, ignoring some parts that
are exclusive to virtual machines
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Development Environment

- Download and install VMWare Player *
- Version 3.1.4 build-385536 used in this training

- Create a new Linux — Ubuntu machine with at least 40GB HD,
1GB RAM

- Download and install Ubuntu 10.04 LTS (or a later version)
from CD ROM or .iso file

- After installing, update system packages

- Update VM Ware Tools to the latest version (8.4.6-385536
on September 05t) *

- Download and install using VM Ware menu item

- Auto mount vmware tools .iso image inside Ubuntu

- Untar VMWare Tools package available inside the .iso image
- Run vmware-install.pl script

*Ignore in native PC
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>3 Development Environment

- Follow the steps described before in LTIB Overview session to install LTIB
- Unpack .tar.gz files to SHOME/Software/Packages/iMX28
- Choose $HOME/Software/Build/iMX28 as destination directory

- Copy scripts from L2.6.35 10.12.01_SDK_scripts to $SHOME/Software/Scripts and add this directory to your
PATH environment variable

- # Export PATH=$HOME/Software/Scripts

- Goto $dHOME/Software/BuiId/iMX28/Itib to configure and build the system images to be flashed in the iMX28
SD car

- Select profile “min Profile” and add the following packages during configuration process
- Freescale Multimedia Plugins/Codecs
= fsl-mm-codec-libs, fsl-mm-flv-codec-libs, gstreamer-fsl-plugins
- freetype,

- gstreamer - gstreamer-plugins-base, gstreamer-plugins-good, gstreamer-plugins-bad, gstreamer-plugins-ugly,
gstreamer FFmpeg plugins

- tslib

- Note: Configuration screens sequence are shown in the next slides
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Configuring LTIB and building system image

=

43 Applicati mE | @ €) : pl4, 3:57PM 13 @ madfsl b
D Q6 madfsi@madfsl-desktop: /tmp/Itib

File Edit 1

Arrow keys navigate the menu. <Enter> selects submenus --->. Highlighted letters are
hotkeys. Pressing <Y> selectes a feature, while <N> will exclude a feature. Press

<Esc><Esc> to exit, <?> for Help. Legend: [*] feature is selected [ ] feature is
excluded

l Platform choice (Freescale iMX reference boards) ---

oad an Alternate Configuration File
S ve Configuration to an Alternate File

< Exit > < Help >

=] madfsl@madfsl-deskto... # U
[T diect input 1o this vitual machine, press Cll+Gi. FLEETIGEEN  vmware
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Configuring LTIB and building system image

=

{3 Applicati System [>_ |} @

D Q6 madfsi@madfsl-desktop: /tmp/Itib

File Edit 1

Arrow keys navigate the menu.

hotkeys.

<Esc=<Esc> to exit, <?> for Help.

excluded

<Enter> selects submenus --->.
Pressing <Y> selectes a feature, while <N> will exclude a feature.
Legend:

[#] feature is selected [ ] feature is

<) ep 14, 3:59PM 1Ty @ madfsl H

Highlighted letters are
Press

--- Choose the platform type

S lection (imx28) --->

--- Choose the packages profile
S lection (use packages in preconfig (Min profile))

oad an Alternate Configuration File
S ve Configuration to an Alternate File

< Exit =

-

< Help =

Z] madfsi@madfsl-deskto...
To direct input to this virtual machine, press Chi+G.
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Configuring LTIB and building system image

Arrow keys navigate the menu. <Enter> selects submenus --->. Highlighted letters are
Pressing <Y> selectes a feature, while <N> will exclude a feature. Press
<Esc><Esc> to exit, <?> for Help. Legend: [*] feature is selected [ ] feature is

hotkeys.

excluded

1) Wed Sep 14, 4:00PM 1y @ madfsl

] lways rebuild the kernel
] roduce cscope index

1 nclude kernel headers

] onfigure the kernel
|
|

*

*] eave the sources after building

uild mfg firmware (NEW)
-- Package selection
--- Target System Configuration
ptions --->
--- Target Image Generation
ptions ---=
oad an Alternate Configuration File
S ve Configuration to an Alternate File

< Exit > < Help >
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{[To direct input to ths virtual machine. press Chk+G. =FLCETIEER  vmware

Freescale, the Freescale logo, AltiVec, C-5, CodeTEST, CodeWarrior, ColdFire, C-Ware, the Energy Efficient Solutions logo, mobileGT, PowerQUICC, QorlQ, StarCore
and Symphony are trademarks of Freescale Semiconductor, Inc., Reg. U.S. Pat. & Tm. Off. BeeKit, BeeStack, ColdFire+, CoreNet, Flexis, Kinetis, MXC, Platformin a
Package, Processor Expert, QorlQ Qonverge, Qorivva, QUICC Engine, SMARTMOS, TurboLink, VortiQa and Xtrinsic are of Freescale Semiconductor, Inc.
All other product or service names are the property of their respective owners. © 2011 Freescale Semiconductor, Inc,




Configuring LTIB and building system image

25
t_': Applications Plac S o) Wed Sep 14, 4:01PM 1y @ madfsl &
D Q6 madfsi@madfsl-desktop: /tmp/Itib

File Edit View Terminal Help

Arrow keys navigate the menu. <Enter> selects submenus --->. Highlighted letters are
hotkeys. Pressing <Y> selectes a feature, while <N> will exclude a feature. Press

<Esc><Esc> to exit, <?> for Help. Legend: [*] feature is selected [ ] feature is
excluded

mx-test

mx-Llib

obs-ng (MEW)

oot stream (NEW)

sing MDDR at boot stream (NEW)
(noinitrd console=ttyAM®, 1152080 root=/dev/mmcblk@p3 rw rootwait ip=none gpmi) efault
noinitrd console=ttyAM®,115280 ubi.mtd=1 root=ubi@:rootfs® rootfstype=ubifs rw gpmi)
noinitrd console=ttyAM®,115200 fec mac=00:08:02:6B:A3:1A root=/dev/nfs nfsroot=16.193
noinitrd console=ttyAM®,115200 root=/dev/ram@ rdinit=/sbin/init fec mac=60:08:02:6B:A
[ tp_imx
[ uc (NEW)
[ theros-wifi (NEW)
| | Freescale Multimedia Plugins/Codecs --->
--- Common package selection list
[ 1 sterisk

< Exit > < Help >

[Z] madfsi@madfsl-deskto...
=FLCETIEER  vmware

Select all the packages listed before
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Configuring LTIB and building system image

1) Wed Sep 14, 4:02PM 1y @ madfsl

Arrow keys navigate the menu. <Enter> selects submenus --->. Highlighted letters are
hotkeys. Pressing <Y> selectes a feature, while <N> will exclude a feature. Press
<Esc><Esc> to exit, <?> for Help. Legend: [*] feature is selected [ ] feature is
excluded

lways rebuild the kernel
roduce cscope index
nclude kernel headers
onfigure the kernel
eave the sources after building
uild mfg firmware (NEW)

-- Package selection
ackage list ---»

--- Target System Configuration
ptions --->

--- Target Image Generation

oad an Alternate Configuration File
S ve Configuration to an Alternate File

< Exit >

[Z] madfsi@madfsl-deskto...

To direct input ta this vitual machine, press CtiltG. (mLCPsONE=BT]  vmware
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Configuring LTIB and building system image
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43 Applicati
200

File Edit Y

m[ | ® &

madfsl@madfsl-desktop:

Arrow keys navigate the menu.
hotkeys.
<Esc=<Esc> to exit, <?> for Help.
excluded

tmp/ltib

<Enter= selects submenus --->.
Pressing <Y> selectes a feature, while <N> will exclude a feature.
[#] feature is selected

Legend:

o) p 14, 4:02 PM

T3 € madfsl

O

Highlighted letters are
Press
[ 1 feature is

[]

--- Choose your root filesystem image type
I

[ 1 una cummand after bu1ld1ng the target image
ead-only root filesystem

< Exit =

[Z] madfsi@madfsl-deskto...
To direct input to this virtual machine, press Chi+G.
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Configuring LTIB and building system image

14, 411PM T3 € m:

Do you wish to save your new configuration?

< No >

<] madfsi@madfsl-deskto...

vmware
Save the new configuration and start building the system
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Preparing the SD Card

- Insert SD card into the SD card reader and connect to the Host PC USB
- Make sure to make the SD card visible to the virtual machine
- You should see the SD available as /dev/sdb, for instance

- If there is one or more partitions in the SD card that are automatically
mounted in the Linux system inside the virtual machine player, make sure to
umount them all

- # umount /media/<sd_card_patition_name>
- Run the mk_mx28_sd script with the SD card device node as argument
- # cd ~/Software/Build/iMX28/Itib
- # mk_mx28_sd /dev/sdb
- After completion, remove and re-insert SD card
- Copy video clip to SD card and remove it

- # sudo cp SHOME/Video/IMXOOBFIlyOver_256kb 320x240 Base.mp4
/media/[your_sd_card_partition]/root

- # umount /media/[your_sd_card_partition]
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Running...

- Connect serial cable

- Run a terminal program (like putty) in the host machine (115200 8N1 no flow
control)

- Set boot mode switch to 1001
- Insert SD card
- Power on the evk
- Linux penguin appears on the LCD
- Testing system image and preparing for next steps
- Login as root — no password needed
- Calibrate touch screen
= # export TSLIB_TSDEVICE=/dev/input/tsO
= #1ts_calibrate
- Test touch screen
= #1s test
- Test gstreamer media framework
= # gplay /root/iMXOOBFlyOver_256kb 320x240 Base.mp4
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Developing Qt Apps
Hands On




Preparing Qt Libraries (Host side)

- Download Qt libraries source code
- gt-everywhere-opensource-src-4.7.4.tar.gz
- Extract the content from package to $HOME/Software/Packages

- Build the libraries for Ubuntu
Install additional packages

= gstreamer0.10-plugins-good, libgstreamer0.10-dev, libglib2.0-dev, libgstreamer-plugins-
base0.10-dev

Change to $SHOME/Software/Build
Create subdirectory qt-4.7.4 and change to it
Configure Qt for PC using following configure line

= # SHOME/Software/Packages/qgt-everywhere-opensource-src-4.7.4/configure -release -
opensource -prefix SHOME/Software/Qt-4.7.4-x86 -multimedia -audio-backend -phonon -
phonon-backend -gstreamer -glib -force-pkg-config -confirm-license

Build and install the libraries for the host machine
« # make && make install

« Qtlibraries will be installed to SHOME/Software/Qt-4.7.4-x86
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Preparing Qt Libraries (Device side)

- Use the same source code already used for the host side

- Build the libraries for iMX28
- Inside gt source code, copy mkspecs/qws/linux-arm-gnueabi-g++ to mkspecs/qws/linux-

mxc-g++
- Edit mkspecs/qws/linux-mxc-g++/gmake.conf and add before the last line
= PKG_CONFIG = pkg-config-wrapper.sh
= QMAKE_LIBS = -Iglib-2.0 -lgthread-2.0 -Igstreamer-0.10 -Ixml2 -1z -lgmodule-2.0 -

Igobject-2.0 -lts -lasound
- Create $SHOME/Software/Scripts/pkg-config-wrapper.sh and make it executable

#!/bin/sh

if [ -n "${SYSROOT:+x}" ];

then
export PKG_CONFIG_LIBDIR="${SYSROOT}/ustr/lib/pkgconfig"
cmd="pkg-config $@ | sed -e 's:-l:-I${SYSROOT}.g' -e 's:-L:-L${SYSROOT}:g™
eval "$cmd"

else
eval "pkg-config $@"

fi
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Preparing Qt Libraries (Device side)

- Build the libraries for iMX28 (continuing...)
- Change to $HOME/Software/Build/iMX28
- Create subdirectory qt-4.7.4 and change to it
- Export SYSROOT environment variable
= # export SYSROOT=$HOME/Software/Build/iMX28/Itib/rootfs
- Configure Qt for iMX28 using following configure line

= SHOMESoftware/Packages/qt-everywhere-opensource-src-4.7.4/configure -
embedded arm -xplatform qws/linux-mxc-g++ -release -opensource -prefix
$HOME/Software/QtEmbedded-4.7.4-imx -qt-gfx-linuxfb -qt-kbd-tty -qt-mouse-tslib
-little-endian -host-little-endian -multimedia -audio-backend -phonon -phonon-
backend -gstreamer -glib -force-pkg-config -confirm-license -
ISHOME/Software/Build/iMX28/Itib/rootfs/usr/include -
L$HOME/Software/Build/iMX28/Itib/rootfs/usr/lib

- Build and install the libraries locally to further deploy to iMX28 SD card
= # make && make install

Qt libraries will be installed to SHOME/Software/QtEmbedded-4.7.4-
imx
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* Preparing Qt Libraries (Device side)

- Besides Qt libraries are all built and available in the host
side, now we need to deploy them to IMX28

- Deploying Qt libraries to the IMX28evk
- Insert the SD card back to the SD card reader in the host PC

- Copy all the content from SHOME/Software/QtEmbedded-
4.7.4-imx to the filesystem of your SD card inside
/home/madfsl/Software/QtEmbedded-4.7.4-imx

= Your SD card is probably mounted under
/media/[sd_card_partition_name]

- Umount your SD card and put it back to the iMX28evk board
- Power on your kit and login
- Tell Qt to use tslib to interpret touch screen as a mouse
- export QWS _MOUSE PROTO=tslib:/dev/input/tsO

Z “freescale" 18



Running some demos...

- After completing preparation steps, you will find lots of Qt
demos and examples inside in your iIMX28evk

- Go to /home/madfsl/Software/QtEmbedded-4.7.4-imx
- You have both demos and examples directories

- Start by trying fluidlauncher
- # cd demos/embedded/fluidlauncher
- # [fluidlauncher -qws

- Note: the -gws argument is necessary so that Qt starts its
Inernal Window Manager
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Installing Qt Creator

- Download Qt Creator binaries for linux
- gt-creator-linux-x86-opensource-2.3.0.bin

- Make it an executable file
- chmod +x gt-creator-linux-x86-opensource-2.3.0.bin

- Run the file and install Qt Creator

- Choose $HOME/Software/IDEs/gtcreator-2.3.0 as installation
directory

- After installing, launch Qt Creator and configure it as
described ahead
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Configuring Qt Creator

- Tools -> Options...
- Tool Chains -> Tool Chains -> Add -> GCC

- Set compiler path to: /opt/freescale/usr/local/gcc-4.4.4-glibc-
2.11.1-multilib-1.0/arm-fsl-linux-gnueabi/bin/arm-none-linux-

gnueabi-gce
Tool Chains

(W) Environment Tool Chains
Text Editor Name Type “
% FakeVim - Auto-detected ) Auto-detected
GCC (x86 32bit) GCC
E,‘ Locator = Mant Manual u

@ Help

{J o+

m Projects

[ o

6 Debugger
# Designer

/¥ Tool Chains
4;] Qt Quick

BB Analyzer
Version Control
@ Code Pasting
' Linux Devices

Compiler path: [foptffreescaIejusrﬂocalfgcc-4.4.4-gIibc-2.11.1-mu|ti|ib-1.01ann-fs|-|inux-gnueabifbin.‘arm-none-lim] M

ABI: M\ Il | et | = Il | =]
Debugger: [ ]u

| Apply | goncel || ok
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Configuring Qt Creator

- Tools -> Options...

- Qt 4 -> Qt Versions -> Add

D Select a qmake executable

qsear‘:h u

) Recently Used
[ madfsl

@ Desktop

L File System
__ Floppy Drive

[i@ Documents
[l Music

[[m) Pictures

@ Videos

[£3 Downloads

|. Add

\amake v |
| Cancel || Open |

L £
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- Tools -> Options...

E] Environment

Text Editor
g FakeVim
[, Locator
@ Help

{J o+

m Projects
[ o

ﬁ Debugger

X Designer

A Tool Chains
.r.ﬂ Qt Quick

[ER Analyzer
Version Control

Code Pasting
I Linux Devices

s Configuring Qt Creator

- Qt 4 -> Qt Versions -> Add (x2)
= /lhome/madfsl/Software/Qt-4.7.4-x86/bin/gmake

= /home/madfsl/Software/QtEmbedded-4.7.4-imx/bin/gmake

ot

Qt Versions
Name gmake Location “
Auto-detected P
- Manual u
Qf 4.7.4 (Qt-4.7.4-x86) /home/madfs|/Software/Qt-4.7.4-x86/binfgmake
/\ |0t 4.7.4 (QtEmbedded-4.7.4-imx) /h dfsl/Software/QtEmbedded-4.7.4-imx/bi k
Version name: | Qt 4.7.4 (QtEmbedded-4.7.4-imx) ]
gmake location: /home/madfs|/Software/QtEmbedded-4.7.4-imx/bin/gmake u
Qt version 4.7.4 for Desktop
No gmlviewer installed.
Helpers: None available Details v
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&> Hello World (C++)

Projects [Z} qt Gui Application
Qt Quick Project m Mobile Qt Application
Ot Widget Project

- File -> New File or Project... e ol

Project from Version Control
Files and Classes

- Qt Widget Project -> Qt Gui Application -

Qt

-> C h Oose e QML Creates a Qt application for the desktop.

Includes a Qt Designer-based main window.
GLSL

General Preselects a desktop Qt for building the
application if available.

- Name: Hello

- Create in: I
/home/madfsl/Software/QtProjects re e

- Select “Use as default project location”

Target Setup

Location
Tar et S etu > N ext B> Targets Qt Creator can set up the following targets for project Hello:
g p Details
Summary ¥ = Desktop Details a

Create Build Configurations: M v
- Class Information -> Next

- Finish

| <Back | Ned> | cancel |
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€3> Hello World (C++) — PC Release

200
File Edit Build Debug Analyze Tools Window Help

Projects $ V- % H X « % manwindow.cpp |~ MainWindow:Main... % » X
QL - i Hello #include "mainwindow.h"

mainwindow.cpp - Hello - Qt Creator

Welcome | |m Hello.pro #include "ui_mainwindow.h"
+ [l Headers MainWindow: :MainWindow(QWidget *parent)
- = EDUW‘?S QMainWindow (parent),
|es] Main.cpp = ui(new Ui::MainWindow)
c«| Mainwindow.c {
. _ @IFIDrms PP ui-=setupUi(this);
' 9
DOUble C“Ck Debua _/ mainwindow.ui !

N — MainWindow: : ~MaznWindow()
Projects i

1

delete ui;

1
An-a_lir'ze
&5
Help

Hello

I:l ] Open Documents

e Main.cpp
RS mainwindow.cpp Hello 3

Application Output slhvg ¢ =P K

P~ Type to locate (Ctrl... Build Issues Search Re... QR o[« 1il iRy Compile O...
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&> Hello World (C++) — PC Release

e W S 0 =4[ (] e 0

File Edit Build Debug Analyze Tools Window Help

C ]
e | layouts — MainWindow QMai
) & Vertical Layout % centralWidget [7] Q
=1
d . menuBar QMel
o ()] Horizontal Layout mainToolBar QToo
Design | 431 Grid Layout statusBar Qstaf
3 Form Layout .
Diebudg 0 i Y L - ter -", i Igv
L i72]] Hon:zontal Spacer [ . B 0 .S MainWindow : QMainWindow
E Vertical Spacer — Used — Property Value
Push Button objectN... | MainWindow
. Tool Button .
@ Radio Button . | Action Editor = Signals & Slots Editor enabled |« :
B :
o Hello %

Il 2~ Type to locate (Ctrl.. Build IssuesSeamh Re... BEI i1l Y Compile O...

Play Around with the UL...
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Hello World (C++) — PC Release

- Build using Ctrl + Shift + F5 or the hammer (down left)
- Run using Ctrl + R or the green play button
- Example:

W | Septembervy 2011 3

Sun Mon Tue Wed Thu Fri Sat
35 28 29 30 31 1 2 3
36 4 5 6 7 8 9 10
37 11 12 13 14 15 16 17
38 18 19 20 21 22 23 24
39 25 26 27 28 29 30 1
40 2 3 4 5 6 7 8
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Hello World (C++) — iMX28 Release

- Click the Desktop icon (above the green play button)
- Select Qt 4.7.4 (QtEmbedded-4.7.4-imx) Release

{§= Horizontal Slider l - B ce|ntral\iN
k D ! calen...ic
? Vertical Slider PushButton | ™ . T h

v Pan) Septembe pushButt
Désign |l Display Widgets | ' s menuBar

= ?) Labe Sun Mon Tue __mainTonlBal

35 28 29 30 -
UM (AT Text Browser Y [ Filter |
s ( J >

Wy Graphics View

@ Calendar ’ ; PR .
LCD Number | =

calendarWidget 2t

objectN... cal

0 2o -
>
o . ditor enabled &
- JE sle H
Dt 4...ease Build: QU4./7.4 (Q Dedded-4.7 .4 Reles
20

-0t_4 7.4 Qt-4.7 4-
| 0t-4_7_4-x86_ Release/Hell
- (2] Tisna ta lacabka (e Duiild leriias CAanrrh DA A o L Far TN
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Hello World (C++) — iMX28 Release

- Try to build again using the hammer
- Something went wrong

b G 0 - D () = 0

File Edit Build Debug Analyze Tools Window Help

0
) Filter ~ | Object Class
Lo Il Vertical Scroll Bar 4 — MainWindow QMa
= {}= Horizontal Slider - % centralWidget [7] Q
d : ) R calen...idget [
P veicalSider | | fushBuiton] "G septembe pusheutzon &l @
pésign | Display Widgets | menuBar QMer
nka) Label sun Mon Tue ___mainThnlRBar OTon 7

35 28 29 30

Debug Text Browser

Q& Graphics View calendarWidget : QCalendarWwi...

12| Calendar Property Value §

LCD Number - |

@ Progress Bar objectN... calendarWwid...

1 = Horizontal Line T Ll = -

e Il Vertical Line , | Action Editor | Signals & Slots Editor enabled | & .
ST @ Assembler messages: gatomic_arm.h .

@ no such instruction: " swpb %dl,%al,[%ebx]" gatomic_arm.h  131]

@ no such instruction: *swpb %al,%sil,[%ebx]' gatomic_arm.h 131

@ no such instruction: *swpb %cl,%dl,[%ebx]" gatomic_arm.h 131

@ no such instruction: *swpb %dl,%al,[%ebx]" gatomic_arm.h 131
@ no such instruction: *swpb %al,%dl,[%ebx]' gatomic_arm.h 131 «

I £- Type to locate (Ctrl.. 1 Build Issues | | 2 =10 Applicatio... Compile 0-
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Hello World (C++) — iMX28 Release

- Click Project on the left
- Delete the default gmake build step and add a custom

2 & ® mainwindow.ui - Hello - Qt Creator
File Edit Build Debug Analyze Tools Window Help

WEELN EVIGESw)oEl | Run Seftings |  Editor Settings | Code Style Settings | Dependencies |
Shadow build: & i

Edit
-

-
Design

Build directory: ware/QtProjects/Hello-build-desktop-Qt_ 4 7 4 QtEmbedded-4 7 4-imx__ Rele

l
Debug

Build Steps

gmake: gmake Hello.pro -r -spec linux-g++-32

Make: make -w in /home/madfsl/Software/QtProjects/Hello-build-desktop-Qt_ 4 7 4 QtEmbe

Clean Steps

An?tize

Help

Make: make clean -w in /home/madfsl/Software/QtProjects/Hello-build-desktop-Qt_4 7 4 QtE|

B —

Build Environment

v

L3

£- Type to locate (Ctrl.. Build Issues Search Re... Applicatio... Compile 0-

w
o
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Hello World (C++) — iMX28 Release

- ... that runs a simple gmake command
- Place it before the Make build step and try building again
- Don'’t forget to enable it

- But you also need to set Command Arguments as %{sourceDir}

File Edit Build Debug Analyze Tools Window Help

Hello
| RunsSettings | EditorSettings | Code Style Settings | Dependencies |
Shadow build: & a
Build directory: \ware/QtProjects/Hello-build-desktop-Qt_4_7_4_ QtEmbedded-4_7_4-imx__Rele
-
@ Build Steps
Debug
Custom Process Step: gmake /home/madfsl/Software/QtProjects/Hello
Anaiyz8 Enable custom process step
2] Command: [qmake
Help
. Working directory: | % {buildDir}
Command arguments: [%{sourceDir}

Make: make -w in fhome/madfsl/Software/QtProjects/Hello-build-desktop-Qt 4 7 4 QtEmbe

P T S

L
3

| Al ©- Type to locate (Ctrl.. Build Issues Search Res... Application Compile Ou....
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Hello World (C++) — iMX28 Release

- Copy $HOME/Software/QtProjects/Hello-build-desktop-
Qt 4 7 4 QtEmbedded-4 7 4-imx__ Release to the SD
card to run in iIMX28evk

- Note: Don’t forget to export QWS _MOUSE_PROTO
environment variable every time you reboot your system
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Hello World (QML)

- Now lets play around with QML
(O New

Choose a template:

Projects

Qt Quick Project <7 Qt Quick Ul

Ot Widget Project ‘ Custom QML Extension Plugin
Other Project

Project from Version Control
Files and Classes

C++

ot

QML Creates a Qt Quick application project =
that can contain both QML and C++ code

GLsL and includes a QDeclarativeView.

General

You can build the application and deploy
it on desktop and mobile target
platforms. For example, you can create
signed Symbian Installation System (SIS)
packages for this type of projects. b
Moreover, you can select to use a set of
premade Ul components in your Qt Quick =

wancel ] | Choose.. |
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&> Hello World (QML)

- Now lets play around with QML

E» Location
Application Type
Qt Versions
Mobile Options

New Qt Quick Application

Introduction and Project Location

This wizard generates a Qt Quick application project.

Name: | HelloQMU |

Create in: [fhomefmadfslfSoftwarethProiects ] “

& Use as default project location

fy ) (Rl

L £
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&> Hello World (QML)

- Now lets play around with QML

2 & @ main.qml - Qt Creator

— [iE HelloQML
i@ HelloQML.pro
+ i@ gmlapplicationviewer
+ [lg3 sources
= [ QML
- [ gml/HelloQML
|| Main.gml

*
Design
-
Debug

L
Projects

| |
Aﬁ;ﬁze
o
Help
HelloQML

=1,

Ot 4...ease

Open Documents
main.gmil

1

File Edit Build Debug Analyze Tools Window Help
Projects 2 Y. = H X « # main.gml

Application Output
Hello 3¢ HelloQML

Ak
Ak

¥ »

import Qtquick 1.0

Rectangle {
width: 360
height: 360
Text {

text: gsTr("Hello World")
anchors.centerIn: parent
1
Mousedrea {
anchors.fill: parent
onClicked: {
Ot.quit():

£~ Type to locate (Ctrl...

Build Issues Search Results JEiftsslllscials i Relii o[Vl Y Compile Output
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Hello World (QML)

- Now lets play around with QML

5 Q@ HelloQML

Hello World

L 4
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Py

> Hello World (QML)

- Play around with the design view...

200

main.qml - Qt Creator

File Edit Build Debug Analyze Tools Window Help

Welcome

Edit

L)
Debug

Projects
]
An?lize
Help

HelloQML

Navigator
Rectangle
T Text -
Ll i ®

= text_inputl &

Library

.lm Resources

Web View

w Qt Quick - Positioner

£~ Type to locate (Ctr

» 4 & main.gml*

¥ Properties

¥ Type
Type MouseArea

Id
¥ Geometry
Position X
Size W
w Visibility
Visibility v - Visible
Clip

Opacity 1.00

MouseArea Layout Advanced
* MouseArea

Enabled <+

ello World

Hover Enabled

ext

ib[ Build Issues §i#d| Search Results =il Application Output B3 Compile Output
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